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Convert Network Configurations

This chapter explains how to convert from one SONET topology to another in a Cisco ONS 15310-CL 
or Cisco ONS 15310-MA network. For initial network turn up, see Chapter 5, “Turn Up a Network.”

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-C136 Convert a Point-to-Point to a Linear ADM Automatically, page 13-2—Complete as 
needed.

2. NTP-C93 Convert a Point-to-Point to a Linear ADM Manually, page 13-4—Complete as needed if 
the in-service topology upgrade wizard is not available or you need to back out of the wizard.

3. NTP-C96 Convert an Unprotected Point-to-Point or Linear ADM to a Path Protection Configuration 
Automatically, page 13-6—Complete as needed.

4. NTP-C95 Convert a Point-to-Point or Linear ADM to a Path Protection Manually, 
page 13-7—Complete as needed if the in-service topology upgrade wizard is not available or you 
need to back out of the wizard.
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NTP-C136 Convert a Point-to-Point to a Linear ADM 
Automatically

Note Optical transmit and receive levels should be in their acceptable range as shown in the specifications 
section for each card in Table 1-1 on page 1-13 for the ONS 15310-CL, or Table 2-1 on page 2-29 for 
the ONS 15310-MA.

Note If overhead circuits exist on the network, an in-service topology upgrade is service affecting. The 
overhead circuits will drop traffic and have a status of PARTIAL after the upgrade is complete. 

Step 1 Complete the “DLP-C29 Log into CTC” task on page 17-44 at a node on the point-to-point or linear 
ADM. If you are already logged in, continue with Step 2.

Step 2 In network view, right-click the span between the two nodes where you want to add the new node. The Select 
Upgrade Protection dialog box appears. 

Step 3 Select Terminal to Linear in the drop-down list. The first page of the wizard, Upgrade Protection: 
Terminal to Linear, appears.

Step 4 The Upgrade Protection: Terminal to Linear page lists the following conditions that must be met before 
adding a new node:

Purpose This procedure converts a point-to-point configuration (two nodes) to a 
linear ADM (three or more nodes) by adding a third node between two 
nodes in a 1+1 configuration. The node being added must be an 
ONS 15454, ONS 15454 SDH, ONS 15327, ONS 15310-MA, or 
ONS 15600 because the ONS 15310-CL has only two optical ports and 
therefore cannot be added between two other nodes. If you have an 
ONS 15310-MA with only two optical ports in use, you can also follow 
this procedure.

Tools/Equipment None

Prerequisite Procedures The in-service topology upgrade procedure requires that the node being 
added is reachable (has IP connectivity with CTC). 

If the PC running CTC and the ONS 15310-CL or ONS 15310-MA 
nodes are not at the same location, two technicians who can 
communicate with each other during the upgrade might be needed.

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• The terminal network has no critical or major alarms.

• The node that you will add has no critical or major alarms.

• The node has a compatible software version with that of the terminal nodes.

• The node has four unused optical ports matching the speed of the 1+1 protection and no 
communications channel has been provisioned on these four ports. 

Note The ONS 15310-CL has two optical ports and therefore cannot be added in between two 
other nodes. It can only be configured as an end node in a linear ADM. The ONS 15310-MA 
has four optical ports and therefore does not have this restriction.

• Fiber is available to connect the added node to the terminal nodes.

If all of these conditions are met and you wish to continue with the procedure, click Next. 

Note If you are attempting to add an unreachable node, you must first log in to the unreachable node 
using a separate CTC session and configure that node. Delete any existing protection groups, and 
any existing DCC terminations as described in the procedure guide for the device you are adding.

Step 5 Enter the node host name or IP address or choose the name of the new node from the drop-down list. If 
you type in the name, make sure it is identical to the actual node name. The node name is case sensitive.

Step 6 Click Next. The Select Protection Group Ports page appears.

Step 7 Select the working and protect ports on the new node that you want to connect to each terminal node 
from the drop-down lists. 

Step 8 Click Next. The Re-fiber the Protected Path dialog box appears. 

Step 9 Follow the instructions in the dialog box for connecting the fibers between the nodes. 

Step 10 When the fibers are connected properly, click Next. The Update Circuit(s) on Node-Name dialog box 
appears. 

Note The Back button is not enabled in the wizard. You can click the Cancel button at this point and 
choose the Yes button if you want to cancel the upgrade protection procedure. If the procedure 
fails after you have physically moved the fiber-optic cables, you must restore the fiber-optic 
cables to the original positions and verify (through CTC) that traffic is on the working path 
before restarting the process. To check traffic status, go to node view and click the 
Maintenance > Protection tabs. In the Protection Groups area, click the 1+1 protection group. 
You can see the status of the traffic in the Selected Group area.

Step 11 Click Next on the Update Circuit(s) on Node-Name dialog box.

The Force Traffic to Protect Path dialog box appears. This dialog box states that it is about to force the 
traffic from the working to protect path for the terminal nodes. 

Step 12 When you are ready to proceed, click Next. 

Step 13 Follow each step as instructed by the wizard as it guides you through the process of refibering the 
working path between nodes and forcing the traffic back to the working path. The final dialog box 
informs you when you have completed the procedure of upgrading from terminal to linear protection.

Step 14 Click Finish.
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Stop. You have completed this procedure. 

NTP-C93 Convert a Point-to-Point to a Linear ADM Manually

Caution This procedure is service-affecting.

Note The node being added must be an ONS 15454, ONS 15454 SDH, ONS 15327, ONS 15310-MA, or 
ONS 15600 because the ONS 15310-CL has only two optical ports and therefore cannot be added 
between two other nodes.

Note Optical transmit and receive levels should be in their acceptable range as shown in the specifications 
section for each card in Table 1-1 on page 1-13 for the ONS 15310-CL, or Table 2-1 on page 2-29 for 
the ONS 15310-MA.

Note In a point-to-point configuration, two OC-N cards/ports are connected to two OC-N cards/ports on a 
second node. 

Step 1 Complete the “DLP-C29 Log into CTC” task on page 17-44 at one of the two point-to-point nodes. If 
you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-C163 Check the Network for Alarms and Conditions” task on page 18-58.

Step 3 In node view, display one of the point-to-point node that will connect to the new node. 

Step 4 Create a 1+1 protection group for the OC-N cards/ports that will connect to the new node. See the 
“NTP-C141 Create Optical Protection Groups for the ONS 15310-CL” procedure on page 4-12 or 
“NTP-C142 Create Protection Groups for the ONS 15310-MA” procedure on page 4-13 for instructions. 

Step 5 Create DCC terminations on the working OC-N card/port that will connect to the new node. See the 
“DLP-C52 Provision Section DCC Terminations” task on page 17-68. (Alternatively, if additional 
bandwidth is needed for CTC management, complete the “DLP-C53 Provision Line DCC Terminations” 
task on page 17-70.) In the Create SDCC Termination dialog box, set the port state to IS. 

Purpose This procedure upgrades a point-to-point configuration (two nodes) to a 
linear ADM configuration (3 or more nodes) manually, that is, without 
using the in-service topology upgrade wizard. Use this procedure if the 
wizard is unavailable or you need to back out of the wizard. 

Tools/Equipment None

Prerequisite Procedures NTP-C141 Create Optical Protection Groups for the ONS 15310-CL, 
page 4-12

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 6 From the View menu, choose Go to Node View to display the new node in node view.

Step 7 Verify the card installation for the new node as specified in the documentation for that device.

Step 8 Set up timing for the new node as specified in the documentation for that device. If the new node is using 
line timing, set the working OC-N card/port as the timing source. 

Step 9 Turn up the new node as specified in the documentation for that device. 

Step 10 Physically connect the fibers between the point-to-point node and the new node. The fiber connections 
should be connected working port to working port and protect port to protect port.

Step 11 On the new node, create a 1+1 protection group for the OC-N cards/ports that will connect to the 
neighbor nodes. For 1+1 provisioning procedures, refer to the documentation specific to the device you 
are adding.

Step 12 Provision section DCC terminations on the new node’s working OC-N cards/ports as specified in the 
documentation for that device. Make sure to set the Port State in the Create SDCC Termination dialog 
box to IS. 

Note Data communications channel (DCC) failure alarms appear until you create DCC terminations 
in the point-to-point node.

Step 13 From the View menu, choose Go to Network View to verify that the newly created linear ADM 
configuration is correct. One green line should appear between each linear node.

Step 14 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-C88 Disable Alarm Filtering” task on 
page 17-109 as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms are present, investigate and 
resolve them before continuing. Refer to the Cisco ONS 15310-CL and Cisco ONS 15310-MA 
Troubleshooting Guide if necessary.

Step 15 Repeat the procedure to add an additional node to the linear ADM.

Stop. You have completed this procedure.
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NTP-C96 Convert an Unprotected Point-to-Point or Linear ADM 
to a Path Protection Configuration Automatically

Note When upgrading VT tunnels, CTC does not convert the VT tunnel to path protection, but instead creates 
a secondary tunnel for the alternate path. The result is two unprotected VT tunnels using alternate paths.

Note If overhead circuits exist on the network, an in-service topology upgrade is service affecting. The 
overhead circuits will drop traffic and have a status of PARTIAL after the upgrade is complete. 

Step 1 Complete the “DLP-C29 Log into CTC” task on page 17-44 at a node on the point-to-point or linear 
ADM. If you are already logged in, continue with Step 2.

Step 2 If the point-to-point or linear ADM is 1+1 protected, complete the “DLP-C138 Delete a Protection 
Group” task on page 18-43. If the point-to-point or linear ADM is unprotected, continue with Step 4.

Step 3 Complete the “DLP-C52 Provision Section DCC Terminations” task on page 17-68 at the nodes that 
support the point-to-point or linear ADM span. (Alternatively, if additional bandwidth is needed for CTC 
management, complete the “DLP-C53 Provision Line DCC Terminations” task on page 17-70.) 
Provision the pluggable port module that is not already in the SDCC Terminations list.

Step 4 From either network or node view, click the Circuits tab. Click the circuit you want to upgrade to select 
it.

Step 5 From the Tools menu, choose Topology Upgrade > Convert Unprotected to Path Protection.

Step 6 To set the path protection parameters, complete the “DLP-C57 Provision Path Protection Selectors 
During Circuit Creation” task on page 17-75.

Step 7 Click Next.

Step 8 Complete one of the following tasks:

a. To route the new path protection circuit manually, complete “DLP-C164 Manually Route a Path 
Protection Circuit in a Topology Upgrade” task on page 18-59.

b. To route the new path protection circuit automatically, complete “DLP-C165 Automatically Route 
a Path Protection Circuit in a Topology Upgrade” task on page 18-59.

Stop. You have completed this procedure.

Purpose This procedure upgrades a point-to-point or linear ADM to a path 
protection configuration without disrupting traffic. You can upgrade 
STS, VT, and VT tunnel circuits to path protection configuration. This 
option is a single circuit operation. 

Tools/Equipment None

Prerequisite Procedures NTP-C27 Provision a Point-to-Point Network, page 5-3

NTP-C29 Provision a Linear ADM Network, page 5-6

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-C95 Convert a Point-to-Point or Linear ADM to a Path 
Protection Manually

Caution This procedure is service affecting. All circuits are deleted and reprovisioned.

Step 1 Complete the “DLP-C29 Log into CTC” task on page 17-44 at a node on the point-to-point or linear 
ADM.

Step 2 Complete the “DLP-C163 Check the Network for Alarms and Conditions” task on page 18-58.

Step 3 Complete the “DLP-C115 Delete Circuits” task on page 18-21 for each circuit. The circuits will be 
recreated after the 1+1 protection groups are deleted.

Step 4 Complete the “DLP-C138 Delete a Protection Group” task on page 18-43 for each 1+1 protection group 
that supports the point-to-point or linear ADM span.

Step 5 Complete the “NTP-C47 Create an Automatically Routed Optical Circuit” procedure on page 6-34 to 
recreate the circuits one at a time.

Step 6 Complete the “DLP-C52 Provision Section DCC Terminations” task on page 17-68 at the protect ports 
in all nodes that will be part of the path protection configuration. Alternatively, if additional bandwidth 
is needed for CTC management, complete the “DLP-C53 Provision Line DCC Terminations” task on 
page 17-70.

Note If you want to add additional nodes to the path protection configuration, see the “NTP-C97 Add 
a Path Protection Node” procedure on page 14-1.

Note Path protection is the default configuration if the cards are installed and the DCCs are 
configured.

Stop. You have completed this procedure.

Purpose This procedure upgrades a point-to-point system to a path protection 
manually, that is, without using the in-service topology upgrade wizard. 
Use this procedure if the wizard is unavailable or you need to back out 
of the wizard. 

Tools/Equipment None

Prerequisite Procedures NTP-C27 Provision a Point-to-Point Network, page 5-3 or

NTP-C29 Provision a Linear ADM Network, page 5-6

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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